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 Introduction: About This Book In this section:
 
 ■■ No Computerese! ■■ A Quick Overview ■■ A Few Assumptions ■■ A Final Word (or Two)
 
 I
 
 f you want to get the most from your computer and your software with the least amount of time and effort—and who doesn’t?—this book is for you. You’ll find Microsoft® Access® 2010 Plain & Simple to be a straightforward, easy-to-read reference tool. With the premise that your computer should work for you, not you for it, this book’s purpose is to help you get your work done quickly and efficiently so that you can get away from the computer and live your life.
 
 No Computerese! Let’s face it: When there’s a task you don’t know how to do but you need to get it done in a hurry, or when you’re stuck in the middle of a task and can’t figure out what to do next, there’s nothing more frustrating than having to read page after page of technical background material. You want the information you need—nothing more, nothing less—and you want it now! It should be easy to find and understand. That’s what this book is all about. It’s written in plain English— no jargon. There’s no single task in the book that takes more than a couple of pages. Just look up the task in the index or the table of contents, turn to the page, and you’ll find the information   1
 
 you need laid out in an illustrated step-by-step format. You won’t get bogged down by the whys and wherefores: Just follow the steps and get your work done. Occasionally, you might have to turn to another page if the procedure you’re working on is accompanied by a “See Also.” That’s because a lot of tasks overlap, and I didn’t want to keep repeating myself. Some useful “Tips” are scattered here and there, and a “Try This” or a “Caution” is thrown in once in a while, but by and large I’ve tried to remain true to the heart and soul of a Plain & Simple book, which is that the information you need is available to you at a glance.
 
 Useful Tasks… Whether you use Microsoft Access 2010 at home or on the road, I’ve tried to pack this book with procedures for everything I could think of that you might want to do, from the simplest tasks to some of the more esoteric ones.
 
 …And the Easiest Way to Do Them Another thing I’ve tried to do in this book is to identify and document the easiest way to accomplish a task. Access 2010 often provides a multitude of methods to accomplish a single end result—which can be daunting or delightful, depending on the way you like to work. If you tend to stick with one favorite and familiar approach, I think the methods described in this book are the way to go. If you like trying out alternative techniques, go ahead! The intuitiveness of Access 2010 invites exploration, and you’re likely to discover ways of doing things that you think are easier or that you like better than mine. If you do, that’s great! It’s exactly what the developers of Access 2010 had in mind when they provided so many alternatives.
 
 2  A Quick Overview
 
 A Quick Overview Your computer probably came with Access 2010 preinstalled, but if you have to install it yourself, the setup routine makes installation so simple that you won’t need my help anyway. So, unlike many computer books, this one doesn’t start with installation instructions and a list of system requirements. Next, you don’t need to read this book in any particular order. You can jump in, get the information you need, and then close the book and keep it near your computer until the next time you need to know how to get something done. But that doesn’t mean the information is scattered about with wild abandon. The book is organized so that the tasks you want to accomplish are arranged in two levels. You’ll find the general type of task you’re looking for under a main section title such as “Creating a New Database,” “Getting Help,” “Exporting Data to a Text File,” and so on. Then, in each of those sections, the smaller tasks within the main task are arranged in a loose progression from the simplest to the more complex. Section 1, which you’re reading now, introduces Microsoft Access 2010 Plain & Simple and tells you what to expect in this book. Section 2 covers what’s new in Access 2010, from the new Backstage View that helps you manage your databases effectively to the new ways you can summarize your data visually. Sections 3 and 4 cover the basics of operating a database: starting Access 2010 and shutting it down, sizing and arranging program windows, getting help from within the program and on the Web, what types of objects are available in an Access 2010 database, and the role each of those objects fulfills. There’s also a lot of useful information about designing and creating a new database, either from scratch or by using built-in database templates; navigating within a database; creating relationships between tables; and getting data from other Access 2010 databases. 
 
 Introduction: About This Book Section 5 is all about customizing your table fields. You’ll discover the different types offi fields available to you; how to add, delete, and rearrange fields; and how to make data entry easier for you and your colleagues. You’ll find the information helpful whether you want to change how a field displays its data, set a default value for a field, ensure that the data entered into the field is appropriate for that field, or enter table data by picking the proper value from a list. Section 6 focuses on working with entire tables, rather than individual fields in a table. Here’s where you’ll find information about entering data quickly, finding and replacing table text, and modifying how Access 2010 displays your data in a table. There’s also a short section here on filtering a table’s contents, which lets you limit the data displayed to exactly what you need to make a decision. Sections 7 through 10 are all about building database objects to take best advantage of your data: creating forms, which let you present your data in an attractive format and enter new table records; building reports, which summarize your data and make it easy to create mailing labels; defining queries, which let you ask specific questions of your table data; and changing the appearance of your forms and reports to make them more attractive or to conform with a company’s color scheme. Section 10 describes how you can use conditional formatting, which is new in Access 2010, to add visual cues that enable you and your colleagues to evaluate report data at a glance.
 
 Section 11 shows you how to summarize your Access 2010 data visually by creating charts. Charts enable you to summarize large data collections quickly, compare historical data to current trends, and provide context for when you discuss specific data points from your tables. Section 12 is about interacting with other programs, such as by including files created in other programs in your databases, adding pictures to forms and reports, or including Microsoft Excel charts in your database. You will also find out how to exchange data with other programs, whether that means exporting Access 2010 table or query data to another program or reading data from another program’s files into Access 2010. The final sections, 13 through 15, deal with more advanced topics: administering your database so you can, if necessary, identify the data that is open for anyone to look over and separate that data from tables or queries that might contain more sensitive information; creating navigation forms that make it easier to move around in your databases; customizing Access 2010 by changing the items that appear on the program’s Quick Access Toolbar and the Ribbon user interface; and creating forms that let you dynamically reorganize your data. If you think these tasks sound complex, rest assured they’re not—Access 2010 makes them so easy that you’ll sail right through.
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 A Few Assumptions
 
 A Final Word (or Two)
 
 I had to make a few educated guesses about the audience when I started writing this book. Perhaps you use Access just for personal reasons—keeping track of your books, music, contacts, and so on. Perhaps you use Access at work to maintain records of your inventory, customers, and the orders they place. Or maybe you run a small home-based business. Taking all these possibilities into account, I assumed that you’d need to know how to create, modify, and work with all the basic Access database objects; to administer the database; and to share the data on the Internet or over your company’s internal network. Another assumption I made is that you have an inherent curiosity about what you can do with Access 2010. Rather than show you how to perform specific tasks, such as designing a database to track client interactions or customer orders, I assumed you wanted a broad base of experience from which to work. I hope that the tasks in this book provide a solid foundation for you to learn more about Access and what it can do for you.
 
 I had three goals in writing this book: ■■ Whatever you want to do, I want the book to help you get it done.
 
 4  A Few Assumptions
 
 ■■ I want the book to help you discover how to do things you didn’t know you wanted to do. ■■ And, finally, if I’ve achieved the first two goals, I’ll be well on the way to the third, which is for my book to help you enjoy using Access 2010. I think that’s the best gift I could give you to thank you for buying my book. I hope you’ll have as much fun reading and using Microsoft Access 2010 Plain & Simple as I’ve had writing it. The best way to learn is by doing, and that’s how I hope you’ll use this book. Jump right in!
 
 2
 
 What’s New in Access 2010? In this section:
 
 ■■ Managing Access Settings and Files in Backstage View ■■ Customizing the Access 2010 User Interface ■■ Creating Databases Using Improved Templates ■■ Building Databases by Re-Using Application Parts
 
 O
 
 ne of the first things you’ll notice about Microsoft Access 2010 is that the program incorporates the Microsoft Fluent interface, also known as the Ribbon, which was introduced in Access 2007. If you used Access 2003 or an earlier version of Access, you’ll need to spend only a little bit of time working with the new user interface to bring yourself back up to your usual proficiency. If you used Access 2007, you’ll immediately notice one significant change: the Microsoft Office Button, located at the top left corner of the program window in Access 2007, has been replaced by the File tab. 
 
 ■■ Creating Navigation Forms ■■ Formatting Database Objects Using Office Themes ■■ Gaining Insights into Data Using Conditional Formatting ■■ Defining Calculated Fields Using the Improved Expression Builder
 
 This section of the book introduces many of the new features in Access 2010: the new Backstage view you use to manage your files; new templates and Application Parts you can use to build databases more quickly; new abilities to customize the Ribbon user interface; new Office Themes, which make formatting simpler and more consistent; and new data visualization techniques, which include Office Themes and conditional formatting.   5
 
 All these improvements combine to make Access 2010 a friendly yet powerful program you can use effectively right out of the box, with a little help from Microsoft Access 2010 Plain & Simple.
 
 Managing Access Settings and Files in Backstage View After releasing the 2007 Microsoft Office System, the Microsoft Office User Experience team re-examined the programs’ user interfaces to determine how they could be improved. During this process, they discovered that it was possible to divide user tasks into two categories: “in” tasks, such as table and report creation, which affect the contents of the database directly; and “out” tasks, such as saving and printing, which could be considered file management tasks. When the User Experience and Access teams focused their attention on the Access 2007 user interface, they discovered that several file management tasks were sprinkled among the Ribbon tabs that contained content-related tasks. The Access team moved all the file management tasks under the File tab, which users can click to display these commands in the new Backstage view.
 
 6  Managing Access Settings and Files in Backstage View
 
 What’s New in Access 2010? Customizing the Access 2010 User Interface
 
 use databases you create from Web database templates on your computer as if they were regular databases.
 
 When the Microsoft Office User Experience team designed the Ribbon interface for Access 2007, they allowed you to modify the program window by adding and removing commands on the Quick Access Toolbar. In Access 2010, you can still modify the Quick Access Toolbar, but you also have much more ability to change the Ribbon interface. Users can hide or display built-in Ribbon tabs, change the order of built-in Ribbon tabs, add custom control groups to a Ribbon tab, and create custom Ribbon tabs that, in turn, can contain custom groups. These custom groups provide easy access to existing Ribbon controls as well as custom controls that run macros stored in the database.
 
 Building Databases by Re-Using Application Parts
 
 Creating Databases Using Improved Templates
 
 After you’ve used Access 2010 for a while, you’ll almost certainly find that you can use database objects you created previously as the basis for new database objects. Access 2010 comes with a number of built-in form templates, called Application Parts, which you can use to accelerate your work. When you click the Create tab on the Ribbon and then click Application Parts, Access 2010 displays the Application Parts that are available to you. Some of the Application Parts are blank forms you can link to another table, but the Contacts, Issues, and Tasks templates in the Quick Start section of the gallery enable you to create and link forms by moving through the steps of a form creation wizard.
 
 Every user is different, but the Access product team has discovered through its research that users frequently create the same types of databases. Some users create databases to track upcoming events; others use them to track the students and faculty at an educational institution; and still others track marketing projects, sales, and tasks they’ve been assigned. Access 2010 comes with a number of built-in database templates you can use to create a database that is prepopulated with objects suited for your application. Access 2010 includes two types of database templates: regular databases and Web databases. A regular database is stored on your computer and can just be used just by someone who has permission to use your computer and to view your files. A Web database can be used on your computer, or it can be stored on a Microsoft SharePoint server. Uploading a database to a SharePoint server enables other users to interact with the database using a Web browser. Uploading a database to a SharePoint site is beyond the scope of this book, but you can Customizing the Access 2010 User Interface  7
 
 Creating Navigation Forms Most databases contain multiple tables, forms, reports, and queries. If you created the database, it can be difficult to remember which elements perform which functions within your database. Your life gets even more complicated if you’re using a database someone else created, or even one you created some time ago. In those instances, you’ll need to examine the database’s contents to discover (or rediscover) how to enter and analyze your data. In Access 2007 and earlier versions of the program, you could create switchboard forms to guide users to the objects they should use for certain tasks. The procedure for creating switchboards was cumbersome, so the Access program team created navigation forms. You can drag forms and reports onto a navigation form, which means you and your colleagues can gain easy access to the elements that enable you to enter, edit, and summarize your database’s contents.
 
 8  Creating Navigation Forms
 
 Formatting Database Objects Using Office Themes Access 2010 includes new capabilities to apply attractive color schemes to your database objects. You could always change the appearance of your forms and reports, but Access 2010 includes collections of complementary colors called Office Themes. You can use the Office Themes that are installed with Access 2010 to format your database objects, or you can create your own themes that reflect your personal design choices or your company’s official color scheme.
 
 What’s New in Access 2010? Gaining Insights into Data Using Conditional Formatting
 
 Defining Calculated Fields Using the Improved Expression Builder
 
 Microsoft Access has always provided powerful tools you can use to manage and summarize substantial data collections. Access 2010 extends those capabilities by allowing you to apply conditional formats that summarize your data visually. A conditional format changes to reflect the numeric values in a report field. For example, if you create a report to summarize your company’s sales performance, you could define conditional formats that indicate whether your company’s performance exceeded its goals, met expectations, or fell short.
 
 In Access 2007 and earlier versions, you could define a field’s value as a function of the values in other fields. For example, you could calculate sales tax due on a purchase by multiplying the order’s total price by the appropriate sales tax rate. To create this type of field, called a calculated field, you use the Expression Builder to define the calculation. Unfortunately, the Expression Builder in Access 2007 was somewhat difficult to use because of its crowded user interface and lack of contextual help tools. In Access 2010, the improved Expression Builder provides a much cleaner user experience. Rather than force you to guess which commands you can use when you create an expression, the Expression Builder makes available only those commands that can be used in the current expression. The Expression Builder also offers to complete the commands you enter using IntelliSense, which enables you to enter your expressions more quickly and with fewer typing errors.
 
 Gaining Insights into Data Using Conditional Formatting  9
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 Introducing Access 2010 In this section:
 
 ■■ Introducing Databases ■■ Starting Access 2010 ■■ Surveying the Access 2010 Window ■■ Opening a Database ■■ Viewing Multiple Database Objects ■■ Closing a Database and Exiting Access 2010 ■■ Displaying and Managing Database Objects ■■ Using the Access 2010 Help System
 
 M
 
 icrosoft Access 2010 is designed to help you store, combine, and ask questions of large collections of data relevant to your business or your home life. You can create databases to track products and sales for a garden supply company, or, just as easily, build databases to keep track of your books and holiday card lists. Regardless of the specific use you have in mind, Access 2010 is a versatile program you can use to store and retrieve data quickly. Working with Access 2010 is pretty straightforward. The program has a number of templates you can use to create entire databases or just parts of them. You also have the freedom to create databases and their components from scratch, giving you the flexibility you need to build any database. This section of the book covers the basics: what a database is and how it works, starting Access 2010, shutting it down, opening databases, displaying database objects, and getting help using Access 2010. There’s also an overall view of the Access 2010 window with labels for the most important parts of the program. You can use that image as a touchstone for learning more about Access 2010.
 
   11
 
 Introducing Databases Storing Data on Index Cards Before computers, a popular way to store data was on index cards. If you ran a gardening supply store, you could keep track of your products by creating a card for each product, dividing the cards into product categories, and then alphabetizing the cards in each section by product name. Each card would contain relevant data such as the product’s name, unique identifier, category, price, description, and the supplier’s name and phone number. To find all the products from a specific supplier, you either needed to keep track of the products on a separate sheet of paper or go through the cards and pull every one representing a product made by that supplier. Storing Data on the Computer If you store the same data on the computer, however, you can find all the products from a specific supplier much more easily. As an example, you might create a Microsoft Word table with a column for each type of data you want to store. With the list in a Word table, you can change the order of the table rows to group all the products from one supplier
 
 together; all you need to do then is scroll down through the table until you find the products from the supplier you want. Using Word to store your data isn’t the best solution, however. One limitation is that there’s no way to combine information from two tables, so you need to write the supplier’s phone number in every row representing a product from that supplier. If that phone number changes, you need to change the phone number entry in every table row representing a product from that supplier. Storing Data in a Database Databases, by contrast, are designed to combine data from several sources into a single table. Once data is entered into a table, it can be combined with other tables in the database to produce valuable information. It’s possible, for example, to store information about suppliers in one table and information about purchase orders in another table. If a supplier changes its phone number, you need to change the phone number only once.
 
 Subdatasheet
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 Datasheet
 
 Introducing Access 2010 Starting Access 2010 After you install Access 2010 on your computer, you can run it to create new databases or to work with existing databases. There are two easy ways to run Access 2010: You can start it from the Start menu or by double-clicking a shortcut on your
 
 desktop. Regardless of the method you choose, you end up with the power of an Access 2010 database at your fingertips in the few seconds it takes your computer to start the program.
 
 Start Access 2010 1 Click the Start button on the taskbar. 2 Click All Programs. 3 Click Microsoft Office. 4 Click Microsoft Access 2010.
 
 3 2 1 4
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 Create a Shortcut for Access 2010 1 Click the Start button on the taskbar. 2 Click All Programs. 3 Click Microsoft Office. 4 Right-click Microsoft Access 2010. 5 Point to Send To. 6 Click Desktop (create shortcut). 7 Press the Escape key twice to close the menu.
 
 3
 
 2
 
 5
 
 1
 
 6 4 Tip You can rename a shortcut by right-clicking it, clicking Rename on the shortcut menu that appears, typing a new name for the shortcut, and pressing Enter. 
 
 14  Starting Access 2010
 
 Introducing Access 2010 Surveying the Access 2010 Window ■■ The title bar displays the name of the database and the window control buttons.
 
 ■■ The Navigation Pane displays database objects of the type you select.
 
 ■■ The tabs on the Ribbon enable you to display different types of commands based on the category you select.
 
 ■■ The object window displays any open database objects.
 
 ■■ The Ribbon contains commands that reflect the active Contextual tab, your position in the database, and the selected objects.
 
 Main tab
 
 Ribbon
 
 Navigation Pane
 
 ■■ The status bar indicates the progress of any ongoing processes.
 
 Title bar
 
 Status bar
 
 Close Restore Minimize
 
 Object window
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 Opening a Database When you start Access 2010, the program opens in Backstage view. A list of recently opened files appears on the left edge of the window, below the File tab. You can select the file you want to open from the list that appears. If the file you want isn’t on
 
 that list, click Open to display the Open dialog box. From the Open dialog box, you can navigate to the folder with the database you want to open.
 
 Open a Database on Startup 1 Start Microsoft Access 2010. 2 Click Open.
 
 2
 
 3 Navigate to the folder with the database you want to open. 4 Double-click the file you want to open.
 
 3
 
 4
 
 16  Opening a Database
 
 Introducing Access 2010
 
 Open a Recently Used Database
 
 2
 
 3
 
 1 Start Microsoft Access 2010. 2 Click Recent. 3 Click the database you want to open.
 
 Tip The names of the last four databases you opened appear in the File tab menu, just above the Info item.
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 Viewing Multiple Database Objects Access 2010 enables you to work with multiple database objects efficiently. In Access 2010, the program displays a tab representing each open object at the top of the object window. If you want to display an object that is currently hidden, you
 
 can click that object’s tab to display it. When you display an object in the object window, you can close the object by clicking its Close button (located at the top-right corner of the object window). 1
 
 Close a Database Object 1 Click the Close button to close the displayed database object.
 
 Scroll Within a Database Object • Click the up or down arrow on the vertical scroll bar to scroll up and down within the object.
 
 Vertical scroll bar Tab
 
 Close button
 
 • Click the left or right arrow on the horizontal scroll bar to scroll left or right within the object.
 
 Tip If you prefer to have Access 2010 display database objects in the same manner that Windows 7 displays program windows (with maximize, minimize, and close buttons), click the File tab and then click Options. In the Access Options dialog box, display the Current Database tab. Then, in the Document Window Options section of the tab, select the Overlapping Windows option button and click OK.
 
 18  Viewing Multiple Database Objects
 
 Horizontal scroll bar
 
 Introducing Access 2010 Closing a Database and Exiting Access 2010 When you finish working with an Access 2010 database, close it to free up system resources and let your computer run other programs more quickly. By the same token, after you complete all the work you need to do in Access 2010, you should exit the program entirely. If you work in a corporate environment or if your database contains sensitive information such as
 
 client addresses or account numbers, you should always close your database any time you walk away from your computer. Although it’s unlikely that someone will wander by and copy or write down sensitive information, it’s better that you make it as difficult as possible for anyone with bad intentions to make off with your data.
 
 Close a Database 1 Click the File tab. 2 Click Close Database.
 
 1 2
 
 Tip
 
 Exit Access 2010 1 Click the File tab.
 
 1
 
 2 Click Exit.
 
 If you finish working with the current database and want to open another, save your work (if necessary), click the File tab, and then click Open.
 
 Caution Clicking the Close button at the top-right corner of the Access 2010 window will exit Access 2010, not just close the active database.
 
 2
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 Displaying and Managing Database Objects Access databases typically contain lots of objects: tables, where you store your data; forms, which enable you to enter data into tables quickly; queries, which enable you to extract subsets of data from your tables; and reports, which summarize your table data and query results. Access 2010 organizes your objects in the Navigation pane, found at the left edge of the program window. You can choose the order in which Access 2010 displays the objects and even choose whether to display a subset of your objects, but you always know where your objects are if you want them. The Shutter Bar, located at the top of the
 
 Navigation pane, enables you to select how you want to view your database’s objects. If you want to maximize the size of the object window, you can hide the Shutter Bar. When you have more than one database object open, Access 2010 represents the objects as a series of tabs across the top of the database window. All you have to do to display an object is click its tab, and closing an object is as simple as clicking the Close button at the top-right corner of the object’s window.
 
 Open a Database Object 1 If necessary, click the Shutter Bar Open/Close button to display the Navigation pane.
 
 4 2
 
 1
 
 2 Click the Shutter Bar.
 
 5
 
 3 If there’s no check mark next to All Access Objects, click All Access Objects. 4 If necessary, click the Show Details button to display the objects in the desired category. 5 Double-click the object you want to open.
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 3
 
 Introducing Access 2010
 
 Control Object Display in the Navigation Pane 1 If necessary, click the Shutter Bar Open/Close Button to display the Navigation pane.
 
 2 1
 
 2 Click the Shutter Bar. 3 Follow one of these steps: • Select Tables and Related Views to display only your data tables and views. • Select Object Type to display all the objects in your database, sorted by object type. • Select Created Date to display all the objects in your database, sorted by the date the objects were created. • Select Modified Date to display all the objects in your database, sorted by the date the objects were last changed.
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 Using the Access 2010 Help System If you need to get help using Access 2010, there are a number of places you can look. One option is to right-click an object (such as a database object or a graphic) to see a list of things
 
 you can do with the object. You can also open the Access 2010 Help files and browse through them to find the answer to a specific question or just to explore. 
 
 Get Suggested Commands from Shortcut Menus 1 Right-click any Access 2010 object to see the shortcut menu of commands. 2 Click a command.
 
 Get Microsoft Access 2010 Help • Click the Microsoft Access Help button on the Ribbon.
 
 22  Using the Access 2010 Help System
 
 1 2
 
 Introducing Access 2010
 
 3
 
 Get Help on the Web
 
 4
 
 2
 
 5
 
 1
 
 1 Click the Microsoft Access Help button on the Ribbon. 2 Click the Search button’s down arrow and select where you want to look for help. 3 Type your search terms. 4 Click the Search button. 5 Browse the topics displayed for help and resources.
 
 Tip Tip You can visit the Microsoft Office Assistance Center site directly by opening your Web browser and typing http://office.microsoft.com/en-us/help/FX100485361033.aspx in the Address box.
 
 If you use Access 2010 at work, you should definitely visit the Microsoft Office Online site at http://office.microsoft.com/ en-us/FX100647101033.aspx. The Office Online site offers help files and product summaries, so you should have no trouble finding articles and demonstrations that can help you get your work done quickly. 
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 Creating a Database In this section:
 
 ■■ Viewing a Sample Database ■■ Creating a New Database ■■ Creating Databases Using Database Templates ■■ Creating a New Table in Design View ■■ Creating a New Table by Typing ■■ Creating a New Table Using a Template ■■ Creating a New Table Using Application Parts
 
 I
 
 f none of the databases you can create using one of the Access 2010 database templates meets your needs, you can create a database and the tables it contains from scratch. When you choose to create a new table, you have complete control over the number of fields, the names of the fields, and what sort of data they can store. After you create the table, you can also add fields from the Field Templates task pane, which contains a wide variety of fields to store such data as times, dates, phone numbers, postal codes, names, addresses, and comments. Once you create a table, whether in Design view or by using a template, you can change its structure as needed, such as renaming an existing field or adding an entirely new field to store additional data.
 
 ■■ Setting a Primary Key ■■ Getting Data from Other Access Tables ■■ Creating Relationships Between Tables ■■ Enforcing Referential Integrity
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 Designing a Database The most basic object in a database is the table in which you store your data. You might be tempted to jam every type of data you want to store into a single table, but that’s hardly ever the right way to design tables in a database. The following guidelines will help you create efficient tables.
 
 One Table per Object The first rule in creating database tables is to ensure that every table stores data about one type of object, whether that object is a person, a product, or an order. As an example, consider the Suppliers table from the Northwind sample database. This table has a field for everything you want to know about a supplier, with nothing extra. Consider this alternative design, which adds fields to describe the supplier’s products. Aside from repeated data, deleting the record representing the last product from a supplier removes all information about that supplier from your database. Rather than risk losing that information, it is much more efficient to create one table for the suppliers and another for the products.
 
 ID field
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 Creating a Database Give Every Table a Primary Key Another important consideration in creating a table is to assign a primary key. This field contains a value that sets a record apart from all other records in the table. In the Northwind database’s Shippers table, that role is filled by the ID field. It’s also possible to create a primary key made up of more than one field, as in the table shown in the following illustration. (Please note that this table is just a sample; it isn’t in the Northwind database.) The ProductID field identifies the product and the SupplierID field identifies the product’s supplier. Because you can order the same product from more than one supplier, both the ProductID and SupplierID fields are needed to distinguish a record from all other records in the table.
 
 Include Foreign Keys A final thing you can do to make your tables more efficient is to include primary key fields from other tables, as with the SupplierIDs field in the Products table. When a primary key from one table is stored in another table, it is called a foreign key. As you see later in this chapter, you can use foreign keys to create relationships between tables.
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 Viewing a Sample Database One of the best ways to get a feel for using Access is to work with an existing database. The Northwind database, which you install along with Access, is a complete database with tables,
 
 Open a Sample Database
 
 queries, reports, and forms you can examine to see what goes into a solid database design.
 
 2
 
 1 Start Access 2010. 2 Click Sample Templates. 3 Click Northwind. 4 Click Create.
 
 Tip The Northwind database contains a form that appears when you open the database. The form enables you to log in using different user accounts. If a database you create doesn’t include accounts for individual users, that form won’t appear.
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 4
 
 Creating a Database Creating a New Database If you want to create a new database from scratch, you can do so by creating a blank database and then adding your own tables and other objects. You can also create a new
 
 Begin a New Database
 
 database based on an existing database, saving yourself lots of time and effort.
 
 1
 
 3
 
 6
 
 1 Click the File tab. 2 Click New. 3 Click Blank Database. 4 Type a name for your database. 5 Click the folder icon. 6 Navigate to the folder where you want to store the database. 7 Click OK. 8 Click Create.
 
 2
 
 7
 
 8
 
 4
 
 5
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 Create a New Database Based on Another Database
 
 1
 
 2
 
 3
 
 1 Open the database you want to use as a model and then click the File tab. 2 Click Save Database As. 3 Navigate to the directory where you want to save the new database. ype a different name for the new 4 T database. 5 Click Save.
 
 4 Caution If you don’t type a new name for your database, you will just save the existing database, not create a new file.
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 Creating a Database Creating Databases Using Database Templates The Microsoft Access product team has one primary goal: to make it as easy as possible for you to create powerful and useful databases that help you get your work done quickly. You must have a great database program to meet that goal, but it also helps if the developers draw on the rest of the Microsoft
 
 Create a Database from a Template
 
 1
 
 community to design databases you can use without modification (for tasks such as tracking your contacts, sales, or workouts) or to use as the basis for your own custom databases. You can find those preexisting databases, called templates, installed on your computer and also on the Office.com Web site. 2
 
 1 I f necessary, click the File tab and then choose Close Database to close any open database. 2 Click a Template Category. 3 Click the desired template.
 
 3
 
 4 Type a name for your database. 5 Click Create.
 
 Tip You can select the folder where you want to save your database file by clicking the folder icon next to the File Name box in Backstage view.
 
 5
 
 4
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 Find Database Templates Online
 
 1
 
 1 I f necessary, click the File tab and then click Close Database to close any open database. 2 Click an Office.com template category. 3 Click the desired template. 4 Type a name for your database. 5 Click Create.
 
 3
 
 4
 
 2
 
 Tip You can search for templates on the Office.com Web site by typing one or more keywords in the Search Office.com For Templates box and clicking the Start Searching button.
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 Creating a Database Creating a New Table in Design View After you plan your database, you can start creating tables to store your data. One good way to define your table’s structure is to start out in Design view. When you look at a table in Design view, you can define the name of a field, select the type of data to go into that field (numerical values, currency values, text, dates, phone numbers, and so on), and write a description for that field. Field descriptions are one of the most overlooked parts of database design. It’s easy to overlook them or see
 
 Create a Table in Design View
 
 them as unnecessary, but the reality is that you might forget what sort of data is supposed to go into a field. You could also leave the company and force someone else to figure out what a particular field should contain. If you’ve ever been handed someone else’s database, you probably encountered a field you weren’t sure about. Please make everyone’s job easier by adding a description!
 
 1
 
 1 Click the Create tab. 2 I n the Tables group, click Table Design. ype a name for the first field and 3 T press Tab. 4 Click the Data Type down arrow.
 
 2
 
 Caution Creating a database table that doesn’t include a primary key field makes it difficult to get data out of your table by using queries and in relationships with other tables. You should always have a primary key field in every table you create.
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 8
 
 3
 
 5
 
 4
 
 5 Select a data type. 6 Type a description for the field. ress Tab and repeat steps 4 through 7 P 7 to add fields. 8 Click the Save button. 9 Type a name for the table. 10 Click OK. 11 When asked whether you want Access 2010 to assign a primary key to your table, follow one of these steps: • Click Yes to have Access 2010 assign a primary key. • Click No to have Access 2010 create the table without a primary key. • Click Cancel to continue without saving your table. 12 Click the Close box for the table.
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 9
 
 10
 
 6
 
 12
 
 Creating a Database Creating a New Table by Typing It might seem strange to want to enter data into a table without first defining the table’s structure, but there’s one scenario where it makes perfect sense: when you’re in a hurry and you have to get the data into the database quickly. When you type
 
 Create a New Table by Typing
 
 data into a blank table, Access 2010 assigns generic names to the fields, such as Field1, Field2, and so on. After the data’s in the table, you can open the table in Design view and name the fields, define data types, and so on.
 
 5
 
 2
 
 1
 
 3
 
 8
 
 1 Click the Create tab. 2 In the Tables group, click Table. ype the data for the first new field 3 T and press Tab. 4 Repeat step 3 until you have typed all the data for one record, and then press Enter twice to return to the first field. 5 Click Save. 6 Type a name for your table. 7 Click OK. 8 Click the Close box for the table.
 
 6
 
 7
 
 Tip When you create a field by typing, Access 2010 defines the table’s first field as a sequentially numbered field named ID, which serves as the table’s primary key field. It’s a good idea to leave the field in the table, but you should rename it to something more descriptive so you can identify it if you use it as a foreign key. If the table’s name is Warehouses, for example, you could name the field WarehouseID.
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 Creating a New Table Using a Template Rather than force you to create a new table from scratch when you start a new database, Access 2010 provides a number of templates you can use to create commonly used fields and tables quickly. When you display a table in Datasheet view, the Fields contextual tab on the Ribbon displays buttons you can
 
 use to add the five basic field types: text, number, currency, date & time, and yes/no. You can select from more built-in field types, or insert a set of multiple related fields by clicking the More Fields button and clicking the desired option from the menu that appears.
 
 Add Fields from the Add & Delete Ribbon Group
 
 4
 
 1 Open a table in Datasheet view. 2 I n the table, click a cell in the Click to Add column. 3 Click the Fields contextual tab. lick the type of field you want to 4 C add.
 
 1
 
 36  Creating a New Table Using a Template
 
 3
 
 2
 
 Creating a Database 4
 
 Add More Types of Fields
 
 3
 
 2
 
 1 Open a table in Datasheet view. 2 I n the table, click a cell in the Click to Add column. 3 Click the Fields contextual tab. 4 Click More Fields. 5 Click the type of field you want to add. 4
 
 Add Multiple Related Fields at One Time 1 Open a table in Datasheet view. 2 I n the table, click a cell in the Click to Add column.
 
 1
 
 3
 
 2
 
 5
 
 3 Click the Fields contextual tab. 4 Click More Fields. 5 I n the Quick Start section of the list, click the set of fields you want to add.
 
 1
 
 5
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 Creating a New Table Using Application Parts Access 2010 enables you to create databases and fields using templates. One new capability in Access 2010, Application Parts, enables you to create a table and several related forms, queries, and reports that display and summarize the data from that table. For example, if you want to maintain a list
 
 Create a Table, Forms, and Reports Using Application Parts
 
 2
 
 of contacts, you can use the Access 2010 Contacts Application Part to create a Contacts table, three forms, a query, and four reports to view your contacts, display a phone list, and create address labels based on that information.
 
 1
 
 1 Click the Create tab. 2 Click Application Parts. lick the Application Part you want to 3 C use. 4 Select the There Is No Relationship option.
 
 3
 
 5 Click Create.
 
 Tip If the Application Part you used relates to an existing table in your database, such as if your Contacts table tracks your contacts with the individuals named in your Customers table, you can use the Create Relationship Wizard to define that relationship.
 
 4
 
 5 38  Creating a New Table Using Application Parts
 
 Creating a Database Setting a Primary Key One aspect of sound table design is to have a field (or group of fields) with a value unique to each row in the table. The fields that have the unique value are called the primary key field(s). Because each row’s primary key field (or fields) contains a unique value, Access 2010 can distinguish each row from all the other rows in the table. Why is that important? Consider what 1
 
 would happen if a store used your phone number to identify you when you called in to place an order. If you change phone numbers and the next person assigned your phone number calls in before you do, the store replaces your information with the new caller’s, potentially wiping out any record you had of doing business with the store.
 
 3
 
 Assign a Primary Key 1 Display the tables in your database. 2 Right-click the desired table.
 
 5
 
 3 Click Design View.
 
 4
 
 7
 
 6
 
 4 Click any cell in the row representing the field to be the primary key. 5 Make sure the Design tab is displayed, and click the Primary Key button. lick the Save button to save 6 C your work. 7 Click the Close box. 2 Tip The primary key shouldn’t contain meaningful information. The best value for a primary key field is a number that Access 2010 increments for each row in a table. That type of field is called an AutoNumber field.
 
 Tip You can create a multiple-field primary key by Ctrl-clicking the row selectors of the fields you want to include in the primary key.
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 Getting Data from Other Access 2010 Tables Many times you find that data from another database would be nice to have in the database you’re working on. You can bring tables (or other objects) into your database using the controls on the External Data tab. Copying tables from another database enables you to use the data as it exists at the time you
 
 Copy a Table from Another Database
 
 2
 
 1
 
 make the copy, so any updates you make to the original table are not reflected in the copy, and vice versa. If you want to copy the structure of the table and not the data, you can do so easily.
 
 3
 
 1 Click the External Data tab. 2 Click Access. 3 Click Browse. 4 Double-click the database from which you want to import the table.
 
 4 Tip After you click OK, you might be able to save the import operation you just created. If you want to save your import so you can repeat it later, select the Save Import Steps check box, type a name for the import operation, type a description for the import operation (if desired), and then click Save Import.
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 Creating a Database 5 5 Select the Import Tables, Queries, Forms, Reports, Macros, and Modules into the Current Database option. 6 Click OK. 7 Click the table or tables to import. 8 Click Options. 9 Follow either of these steps: • Select the Definition and Data option to copy the table structure and data.
 
 6
 
 • Select the Definition Only option to copy just the table structure.
 
 7
 
 10 8
 
 10 Click OK.
 
 Tip You can import data from other types of database objects by clicking the object type (for example, Queries) in the Import Objects dialog box and then clicking the object from which you want to get your data.
 
 9
 
 See Also
 
 Tip
 
 For information on linking to a table instead of copying it, see “Linking to a Table in Another Access 2010 Database” on page 196.
 
 If you clicked a table to include it in the list of tables to be imported, but have changed your mind, you can click the table again to deselect it.
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 Relationships Explained One-to-Many Relationships One of the strengths of Access is the ability to create relationships between tables. As an example of a relationship, consider the Customers and Orders tables from the Northwind sample database.
 
 42  Getting Data from Other Access 2010 Tables
 
 In the Northwind business case, every order comes from a single customer. Of course, a customer can place more than one order, which means that the Customers and Orders tables are in a one-to-many relationship with the Customers table on the “one” side and the Orders table on the “many” side.
 
 Creating a Database Many-to-Many Relationships It is also possible for two tables to be in a many-to-many relationship, where multiple records from one table relate to multiple records from another table. As an example, consider the Products and Orders tables in the Northwind database: A product can be included in many orders, and an order can include many products. The problem is that you can’t relate the two tables directly without adding fields to the Orders table to hold spots for more than one item, as in the following incorrect example.
 
 This table is poorly designed because it forces you to enter data about the customer and the order in each record, instead of just once, and an order can’t be for more items than you have spots in the table. The proper way to manage the relationship is to create a transition table, which bridges the gap between the Products and Orders tables. In the Northwind database, the Order Details table is a transition table. The Order Details table is on the “many” side of two oneto-many relationships—the first with the Products table, and the second with the Orders table. By bridging the two tables, it lets you manage the relationship between the Orders and Products tables without resorting to improper table design.
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 Creating Relationships Between Tables When the primary key from one table is present in another table, you can create a relationship between the two tables. This ability to link two (or more) tables together is one reason why relational databases are so powerful: You
 
 Define a Relationship
 
 make your data easier to read by creating simple tables and then use your computer’s processing power to combine tables of data into useful information you can use to make business decisions.
 
 2
 
 1
 
 1 Click the Database Tools tab. 2 Click Relationships. 3 If one or more of the tables you want to relate doesn’t appear in the Relationships window, click the Show Table button.
 
 3
 
 4
 
 4 Click the first table to add to the Relationships window. 5 Click Add. 6 Repeat steps 4 and 5 as necessary. 7 When you finish adding tables, click Close. Tip To delete a table from the Relationships window, right-click the table’s title bar and then click Hide Table.
 
 5
 
 44  Creating Relationships Between Tables
 
 7
 
 Creating a Database 8
 
 10
 
 9
 
 8 Drag the primary key field from the first table to the corresponding foreign key field in the second table. 9 Click Create. 10 Click the Close button to close the Relationships  window.
 
 Tip The foreign key and primary key fields don’t have to have the same name in each table; they just need to denote the same data.
 
 Caution It is possible to add a table more than once: make sure you click the name of the table you want to add! Nothing bad happens, but you won’t have added the tables you want to work with.
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 Enforcing Referential Integrity When you create a relationship between two tables, you need to make sure that data in the two tables remains consistent. If you no longer order from a supplier, you would want all
 
 products from that supplier deleted from the Products table when you delete the supplier’s data from the Suppliers table. Enforcing referential integrity lets you do that. 2
 
 Enforce Referential Integrity
 
 1
 
 1 Click the Database Tools tab. 2 Click Relationships. 3 Double-click the line representing the relationship you want to edit. 4 Select the Enforce Referential Integrity check box.
 
 6
 
 7
 
 • Selecting the Cascade Update Related Fields check box means Access 2010 will change the values in foreign key fields when the corresponding primary key field’s value is changed. • Selecting the Cascade Delete Related Records check box means that deleting a record from the primary field in a relationship will cause Access 2010 to delete all related records in the second table. 5 Click OK. 6 Click the Save button. 7 Click the Close box of the Relationships window.
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 4
 
 3
 
 5
 
 5
 
 Customizing Fields In this section:
 
 ■■ Working with Tables ■■ Assigning a Data Type ■■ Viewing or Changing Field Properties ■■ Introducing the Expression Builder ■■ Formatting Field Contents ■■ Creating Input Masks ■■ Assigning Required Fields and Requiring Data Entry ■■ Setting Default Values ■■ Indexing Field Values ■■ Validating Data Entry ■■ Creating a Lookup Field
 
 W
 
 hen you create a database table using a wizard, Microsoft Access 2010 assigns a data type and properties to each field in the table. When you create a table from scratch or if you want to modify the settings Access 2010 applied to the table, you can change a field’s properties so it stores data efficiently and interacts well with other fields in the database. Access 2010 also gives you several ways to facilitate accurate data entry. When you and your colleagues need to enter data such as phone numbers or postal codes, you can define an input mask that visually indicates the data pattern required for that field. If a field often contains the same value, you can set that value as the default. And when there are only a few possible values for a field, such as when you need to select a category from your company’s list of product categories, you can create a lookup list from which to choose the appropriate value or values. Finally, you can enable your colleagues to attach files, such as customer faxes, to a record; or create a memo field that enables users to add their own comments without being able to edit or delete existing comments.
 
 ■■ Creating an Append-Only Memo Field ■■ Creating an Attachment Field   47
 
 Working with Tables It’s easy to create tables in Access 2010, but you’re not stuck with the first version of the table. After you create a table, you can modify it by adding, deleting, and reordering fields. While the order of your fields doesn’t affect how your table functions within the database, changing the fields’ order can make it
 
 Delete a Field
 
 1
 
 easier for you and your colleagues to understand your table’s structure when you view the table’s data in Datasheet view and structure in Design view. In addition to the instructions to modify your table, this section includes a table that describes the data types available to you in Access 2010. 2
 
 3
 
 4
 
 1 Open a table in Design view. 2 Click the row selector of the row you want to delete. 3 Click the Delete Rows button. 4 Click Yes to confirm that you want to delete the row.
 
 Caution Deleting a primary key field prevents you from distinguishing a table row from other table rows or relating the table to other tables in your database.
 
 Tip If you add a field to a table that already contains data, remember to set aside time to fill in the new data for any existing records.
 
 48  Working with Tables
 
 Caution Deleting a field gets rid of all the data in that field—it can’t be retrieved. You should strongly consider making a backup copy of a table when you make a significant change such as deleting a field.
 
 Customizing Fields
 
 Add a Field
 
 1
 
 2
 
 3
 
 4
 
 5
 
 1 Open a table in Design view. 2 Click the row selector of the row below where you want the new field to appear. 3 Click the Insert Rows button. 4 Type a name for the new field. 5 Assign a data type.
 
 Arrange Fields
 
 1
 
 3
 
 2
 
 1 Open a table in Design view. 2 Click the row selector of the row you want to move. 3 Drag the row selector to the new position. A line appears to show where the row will be moved in the table.
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 Assigning a Data Type In Access 2010, some operations such as arithmetic or date comparisons require you to assign the proper data type to a field. You have a number of data types to choose from, depending on your needs. For example, creating an AutoNumber field directs Access 2010 to add a sequential value to a table row automatically, which is useful for distinguishing a particular
 
 Pick a Data Type 1 Open a table in Design view. 2 Click in the Data Type box of the field you want to edit. 3 Click the down arrow. 4 Click the data type to assign to the field.
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 1
 
 table row from all other rows in the table. Creating a memo field gives you and your colleagues a place to type notes about a table record, making it possible for information workers to add details as to why they entered data in a certain way or to add customer comments.
 
 4
 
 2
 
 3
 
 Customizing Fields Available Data Types Data Type
 
 Description
 
 Text
 
 A series of numbers and letters of up to 255 characters.
 
 Memo
 
 Same as the Text data type, with an upper limit of 64,000 characters.
 
 Number
 
 Numeric data.
 
 Date/Time
 
 Dates and times between the years 100 and 9999.
 
 Currency
 
 Primarily monetary amounts, but can also be used to set a specific number of digits to the right of the decimal point.
 
 AutoNumber
 
 A unique number for each row, either one greater than the value in the most recently created row or a random value.
 
 Yes/No
 
 A Yes/No, On/Off, or True/False value.
 
 OLE Object
 
 A link to another file, such as a Microsoft Word document.
 
 Hyperlink
 
 A link that opens a file, a location in a file, or a Web address.
 
 Calculated
 
 Results of a calculation. The calculation must refer to other fields in the same table. You use the Expression Builder to create the calculation.
 
 Lookup
 
 A list of values derived from either an existing table (or query) field or from a list you enter directly; you can choose to allow users to assign multiple values to the field.
 
 Attachment
 
 A file, or set of files, included as part of the record.
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 Viewing or Changing Field Properties Every field has a number of properties, such as the maximum number of characters allowed in the field. Setting a field’s properties helps control the type of data entered into the field, which makes it less likely that your colleagues will enter erroneous
 
 View Field Properties
 
 data. The properties available to you are different for each data type, but you can view all the available properties in the Field Properties pane, which appears at the bottom of the screen when you open a table in Design view.
 
 1
 
 2
 
 1 Open a table in Design view. 2 Click within the row representing the field with the properties you want to change. 3 Click the name of the property you want to change. 4 Follow any of these steps: • Type a new value for the property. • Click the down arrow, and choose a new value from the list. • Click the Build button to open the Expression Builder. 3
 
 52  Viewing or Changing Field Properties
 
 4
 
 Customizing Fields Introducing the Expression Builder When you set a validation rule to check field data or when you create a calculation to find the total value of an order, you create an expression to evaluate the contents of one or more table fields. Rather than make you memorize how to identify
 
 the fields you want to use or which operators are available, you can use the controls in the Expression Builder to create your expressions quickly.
 
 The expression appears here Double-click to see categories of available functions Double-click to see functions within a category Click to see a list of available constants Click to see a list of available operators
 
 Click OK when you’ve created your expression
 
 Click Help to get more help using the Expression Builder The available items for a group (or subgroup) appear here Click a subgroup to narrow the list of functions, constants, or operators displayed
 
 Viewing or Changing Field Properties  53
 
 Formatting Field Contents Access 2010 lets you choose how to display the contents of data in your tables. For example, you can display the field’s contents in all upper- or lowercase letters, change the color of the text, or display characters in addition to the data entered into the field. For example, if a product is only available by the
 
 Change Field Format
 
 case, adding the word “cases” after the number would remove any confusion as to the quantity being ordered. Adding formatting instructions only changes how data is displayed—it doesn’t affect the data itself.
 
 1
 
 2
 
 1 Open a table in Design view. 2 Click the name of the field to format. 3 Type the formatting instructions in the Format property box.
 
 Tip A down arrow appears in the Format property box when the box is active; clicking the down arrow displays a list of recently used formats. To reuse a format, simply click it.
 
 3
 
 54  Formatting Field Contents
 
 Customizing Fields Character
 
 Resulting Format
 
 !
 
 Left align.
 
 

 
 Uppercase.
 
 &
 
 Instruction to follow.
 
 “Text”
 
 Display the text as it appears between the quotes. &” kg” displays the value “16” as “16 kg.”
 
 (space)
 
 Insert a blank space.
 
 \
 
 Display the next character as entered. &\m displays the text “100” as “100m.”
 
 @
 
 Require a character; @@@-@@@@ displays the text “5550011” as “555-0101.”
 
 *
 
 Fill all blank spaces in the field with the named character. In a field with a maximum character property of eight, &*# displays “five” as “five####.”
 
 [color]
 
 Display the field’s contents in one of the eight available named colors (black, blue, green, cyan, red, magenta, yellow, and white).
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 Creating Input Masks Databases are only as good as the data they hold, so it’s important that you and your colleagues enter data correctly. You can guide data entry in text and date fields by creating an input mask, which gives you a template to follow when entering data in a field. For example, if your company’s product codes follow
 
 Define an Input Mask
 
 1
 
 a particular pattern, you can establish that pattern by using an input mask, ensuring that you and your colleagues enter the right sort of data into the field.
 
 2
 
 6
 
 5
 
 7
 
 1 Open a table in Design view. 2 Click the field for which you want to create the input mask.
 
 8
 
 3 Click in the Input Mask property box. 4 Click the Build button. 5 Click Yes to save the table.
 
 9
 
 6 Click the desired input mask. 7 Type values in the Try It box to ensure that the input mask works as expected.
 
 10
 
 8 Click Next. 9 To choose a new placeholder character, click the Placeholder down arrow and then click the new character.
 
 3
 
 4
 
 10 Click Next.
 
 Tip
 
 11 Select the option indicating whether you want to store the data as entered or with the characters in the input mask.
 
 Assign the Text data type to fields holding phone numbers so that you can take advantage of the Phone Number input mask.
 
 12 Click Finish.
 
 11
 
 12 Tip If the data entered into a field is sensitive and shouldn’t be read by someone watching as you or your colleague enters the data, choose the Password input mask.
 
 56  Creating Input Masks
 
 Customizing Fields 1
 
 Edit an Input Mask 1 Click the field to which you assigned an input mask. 2 Click in the Input Mask property box. 3 Change the input mask using the available symbols. Symbol
 
 Description
 
 0
 
 Required digit (0 to 9)
 
 9
 
 Optional digit (0 to 9)
 
 #
 
 Any digit or space
 
 L
 
 Required letter
 
 ?
 
 Optional letter
 
 >
 
 Makes following characters uppercase
 
 
>) button. You can also remove a field by clicking the Remove (					    
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